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[bookmark: _GoBack]I. Introduction								
 
· Introductions
· Housekeeping


II. Class Learning Objectives 

By the end of this class, you will be able to:
1. Explain when to use a Pivot Table and when to use a Pivot Chart
2. Create a Pivot Table and Pivot Chart
3. Discuss how to print a spreadsheet or a custom print area 
4. Explain the VLOOKUP function


III. Pivot Tables

 Pivot Table and Chart spreadsheet
· When is using a pivot table appropriate?
1. Use it to summarize a large chunk of data.
2. Use it when you have
· a simple worksheet where rows are for a single data point 
· your spreadsheet uses column headers
· You don’t have any empty cells or blank rows
· You don’t have any data surrounding the worksheet
· These are the questions that we’re going to have the Pivot Table answer:
· What are the total inventory sales? 
· How much inventory you have in Ford and in Toyota?
· How much inventory broken down by the type of vehicle (car, truck, SUV)?

Check sum of price in Data
· Let’s find the sum of the Inventory’s Price (total inventory sales)
1. Place your cursor in the Price header (E in this case) until it turns into an arrow pointing down at the column.
2. Click on the header.
3. The status bar should now have the Average, Count, and Sum of the column listed.
· Take note of the SUM.





Enter Pivot Table and check sum of Data.
1. Click anywhere in the data.
2. Go to the Insert tab.
3. Click on Pivot Table.
4. Choose New Worksheet if not already selected
· Click on OK.
5. You should now have a Pivot Table.
6. Select Price in the field list. 
· Check that the total matches the Status Bar.

In the Pivot Table, report on Brand and Price
Let’s figure out how much inventory you have in Ford and in Toyota, and while you’re at it, let’s break down the data by the type of vehicle (car, truck, SUV).
· Tip: the fields we can choose from are the column headings from the worksheet with all our car information on it.
· We can drag and drop these labels to create data reports.


· Drag and drop Brand to the Column Labels field.
· You will see the brands populate horizontally across the page. These will be your column headings.[image: ]

· Drag and drop Type to the Row Labels field.
· You will see car, truck and SUV populate vertically on your page. These will be your row headings.
· Drag and drop Price to the Values (the field with numerical data) field.
· The totals appear in the grid we set up with the column and row labels. This is the total amount of inventory (in dollars) we have in each type of vehicle.
· Tip: Just like with Charts, if you click away from the pivot table, you lose the Pivot Table tabs. You can bring back your sidebar and tabs by clicking back on your pivot table.
Remove all values by unchecking them in the Fields List.

· Comprehension Check: Build a pivot table displaying how much inventory (total $ value) we have in vehicles by brand, year and type.

Pivot Table features 
· Show/Hide (-/+) buttons in table next to Car/SUV/Truck
· Use the Pivot Tables Tools Analyze tab and notice the Show group – show Fields pane, turn on/off -/+ buttons, show/hide Field Headers
· Double-click in a pivot table cell to see the underlying data, which will be displayed in a new worksheet
[image: ]
· Click UPDATE button at bottom of PivotTable Fields pane if underlying data changes – added, deleted, etc. Click the Defer Layout Update box to enable this feature. 

Pivot Table Functions 
Currently, we have only looked at using the AutoSum function, adding all of the values in the Price column.
· What if I wanted to look at how many vehicles I had in each category?
1. You can change the function (sum/totaling is default, but there’s also average, minimum, maximum, etc.) that is used in your pivot tables. 

Let’s change pivot table to perform a count. 
· Click on the drop down arrow next to Sum of Price in the values field.[image: ]

· Click on Value Field Settings.
· Click on Count and click OK.
1. Tip: Notice the Number Format button for changing values to appear as numbers, currency, etc.[image: ]

2. Note you can also right-click on a value in the Pivot Table and select Value Field Settings or Summarize Values By to change the function (for example from Sum to Count.)

· Comprehension Check: Now change the function back to Sum.
· If you feel particularly ambitious, change the formatting of the values so they look like money.

 Custom calculations - “show value as” [image: ]

· Right now we’re seeing the data as the raw dollar value of our inventory for each brand, type, and year.
· What if we wanted to see the percentage of our total inventory that consists of 2012 Ford Trucks? We can see a data point as a percentage of various totals already in our pivot table.
· Click on a cell inside the pivot table
· Right-click and choose ‘Show Value As’
1. Tip: Note we can also go to the Values Pivot Table fields area and use the drop-down menu to select Value Field Settings and then use the Show Value As tab.
· Choose % of Grand Total - it shows that 16% of our total inventory are 2012 Ford Trucks.

· Comprehensive Check: Change data to % of Column Total 

Filter a Pivot Table
· At this point in time, we are seeing a summary of all of the vehicles on our lot.
· What if we only wanted to see data regarding Fords? What about SUVs and Trucks?
· There are dropdown arrows next to the Row and Column Labels. 
[image: ]



Activity: Let’s turn on a filter to only display Fords.
· Click on the filter dropdown arrow for Column Labels.
· Uncheck Toyota and click OK.
· Whatever fields are checked will display in our pivot table.
· Here we see data related only to Fords.
· Notice that there are essentially two columns of repeated data though – column for Ford and another Grand Total. We’ll come back to that in just a moment.
· Clear the filter from Column labels by clicking the filter icon and clicking Clear Filter from Brand.

Activity: Let’s turn on a filter to display only SUVs and Trucks.[image: ]

· Click on the filter icon for Row Labels.
1. Because there are 2 fields in our row list, you only see the top one. If you have Year on top of Type, you will only see options for Year.
· Use the Select Field area and use the dropdown menu to select Type.
· Uncheck Car and click OK.[image: ]

1. We now only see data related to SUVs and Trucks.
· Clear the filter from Type.
1. Remember, you’ll have to use the field select dropdown menu to select Type.


Sorting a Pivot Table	
· Just as we can sort a raw spreadsheet, we can use the filter button to also sort our fields – A-Z (Ascending) or Z-A (Descending) 

Let’s alphabetize our list of vehicle types A-Z[image: ]

· Click in a cell containing vehicle type data (car, truck, SUV)
· Click the Filter Button in the column header – remember we’re using Type and not Year.
· Choose Sort A-Z

Subtotals and Grand Totals 
· When we filter our pivot table down so we are only showing one category of information (like we did with Ford earlier), we see duplicate data on the screen. 
· That’s because Grand Totals are automatically included.  We can change whether they are included, plus we can add subtotals if we want.

Add subtotals[image: ]

· Click anywhere in the Pivot Table
· Use the Pivot Table Tools Design tab 
· Select Subtotals
· Choose Show All Subtotals at Bottom of Group



PIVOT CHART
· Click on Pivot Chart in the Tools grouping of the Pivot Table Analyze tab.
· Select the type of chart you want to display and click OK.
1. All of your chart editing tools are exactly the same as what we looked at earlier in class.

IV. Printing
Open the Advanced Formatting worksheet.

Print Preview
· Before you print any document, you want to make sure it is going to look the way you expect.
· With Excel, there is even more to consider. Large workbooks won’t fit on a single sheet of paper. Many won’t even fit in a single column of pages going down, so we need to see how it’s going to print to see if we need to make any adjustments.

Perform Print Preview
· Click on File tab then choose Print.
· This spreadsheet obviously doesn’t fit on one page.
· Scroll through several pages to show how the information displays.
· We lose context for some of the numbers – headers are lost after the first page
1. We need to give Excel more information on how to print the file.

Print Titles (Adding row and column headers to each printed page)
· Let’s say we print this report every day and if we drop it, we have no way of knowing the page order or which version of the report we have.
· We need to give Excel more information to print the file the some useful information about the file. 
· Close Print Preview using the Arrow button in top left corner

Let’s repeat rows at the top and columns to the left.[image: ]

· Click on Print Titles on the Page Layout tab.
· On the Sheet tab, under Print titles, click in the field for ‘Rows to repeat at top.’
· Click on the header for Row 1.
· Click in the field for ‘Columns to repeat to left.’
· Click on the column header for column A.
· Click on Print Preview button at bottom of dialog box.
· Scroll through several pages.
· We have a context for the numbers on the page.
· But! If you scroll through the pages, you’ll see that there is some information related to 3M Company on page 1, but then we see more information all the way over on page 12. We probably want these two pages to be one right after the other. Let’s tell Excel the page order.
· Close Print Preview using the Arrow button in top left corner.
Set Print Page Order
· Click on Print Titles on the Page Layout tab.
· On the Sheet tab in the Page Order section, click on Over then Down.
· Click on Print Preview button at bottom of dialog box.
· [image: ]Scroll through several pages.
· Now we see that all the information about 3M Company is printed one page right after another. Yay!
· Close Print Preview using arrow in top left corner.


Page Numbers and Footers
· Click on Print Titles again in Page Layout tab.
· Click on Header/Footer tab in the dialog box and in the dropdown menu for footer to select Page 1 of ?.
· But what if we print this report daily? Would it be useful to have more information, like the date printed or the file name?
· On the Header/Footer tab, click on Custom Footer.[image: ]

· In the LEFT section, type “Printed on” and then click Insert Date button (looks like a calendar)
· In the RIGHT section, click Insert File Name (Excel icon)[image: ]

· Click on Print Preview button at bottom of dialog box.
· Revel in the awesome changes made to the document on every page.
· Close Print Preview.

Set Print Area
· If you need a quick print or to print a small area of a larger worksheet, you can use the PRINT AREA function to choose what to print.
· Select a block of cells
· Go to Page Layout tab and choose PRINT AREA in Page Setup group
· Choose SELECT PRINT AREA
· Go to File Tab and select Print (or use CTRL+P) to preview what will be printed
· To clear your selection, go back to PAGE LAYOUT tab, PRINT AREA and choose CLEAR PRINT AREA. 















V. VLOOKUP Function
· Watch the VLOOKUP video from Exceljet.com (3:10): https://exceljet.net/tips/how-to-use-vlookup 

· Explanation: If your information is laid out in columns and you want Excel to look up information up and down the columns, you’ll need to use a Vlookup function.  The “v” in the function is an abbreviation for vertical. 

Some Tips:

· Vlookup requires that the table of data is structured. 
· The lookup values should appear in columns to the left
· The data that you’re trying to retrieve appear in columns to the right.  

· Keep in mind that Vlookup will match the first value only.
· So, if you have a table with duplicates, then you will only get the first value.

· Make sure to sort your table of information in ascending order.

There are more tips on Exceljet.net.  


4 VLOOKUP Arguments
1. Lookup_value: the value you’re trying to lookup.  An example is an id number or someone’s name.
[image: ]
2. Table_array: the table or range where you want to lookup the value
[image: ]
3. Col_index_number	the column number in the range that will have the return value
[image: ]1
2
3
4
5
6

4. [range lookup]	
Approximate match as indicated by 1/True (default setting) or Exact match as indicated by 0/False 


Lookup information in various columns using Vlookup
1. In the class file, go to the Vlookup Function worksheet
2. Highlight cell range C5:H24
3. Go to the Formulas tab.  In the Defined Names group, click on the Define Name dropdown and choose Define Name.
4. Change the Scope to Vlookup Function.
5. Enter dataX as the name and click Ok.  Naming cells or ranges will make our function easier to read.  Also, it will turn cells and ranges into an absolute references.  This will allow us to easily copy the formula.  
6. Select cell C2 and open up the Define Name dialog box again.  Name this cell idX. 
7. You will now be entering the function into the worksheet. Follow along with the instructor. The formula should look like this in cell D2: =VLOOKUP(idX,dataX,2,FALSE).  

Translation:
This means that we will look up whatever id number that we’ve typed in cell C2 within the Data range. We will retrieve the first name that’s in column number 2.  We have set the range lookup to False so that we get an exact match and not an approximate match.

Now, we will use the fill handle to copy this function across so that we can get the other missing values. However we need to correct the functions after they’ve been copied over.  We’re getting the same values because we used absolute cell references.  Remember, when you name a cell or cell range, it will become an absolute cell reference in any formulas that use it.

8. Select cell D2, hover the mouse over the lower right corner until it turns into the black cross.  This is your fill handle. Drag it across to cell range E2:H2.
9. In cell E2, change the column number to 3.
10. In cell F2, change the column number to 4.
11. In cell G2, change the column number to 5.
12. In cell H2, change the column number to 6.

Lookup information from one worksheet and use it in another worksheet using Vlookup
1. Go to the Vlookup Part 2 worksheet.
2. Select cell D5 and type =VLOOKUP(C5,'Vlookup Function'!dataX,6,0)
3. Use your fill handle and copy the function down the column.  You can do this quickly by double clicking on the fill handle.




IX. Wrap Up 

· Class review

· Questions? 

· Resources for learning more: 

1. Technology page – www.vbgov.com/tech-ed (also under Adults)
· Upcoming classes
· Tech Help service information
· Teach Yourself Technology

2. Exceljet.net
3. Lynda.com demonstration
· Go to VBPL website: www.VBgov.com/libraries -> Digital Library -> Learn
· You will need to complete a one-time account setup with their name and email address
· Subsequent access will be via our library website and login will just be their library card number and PIN
· Browse or search topics
· Use filter options on the left side of page to narrow results by skill level and subject 
· Use + button to add courses to your playlist, your progress will be saved. 
· Certificates of completion at end of most courses.

· Google search – for text-based or video instructions

· Homework:
· Practice using the outline and practice file from class! Save to a USB drive prior to leaving.

· Please complete the evaluation – your anonymous feedback is appreciated!

· Thank you for your time and for attending this class!
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